:{EN ESAS Application Note

Renesas RA Family

Getting Started with the Graphics Application

Introduction

This application note describes the creation of an application that uses Graphical User Interfaces with an
EK-RA6M3G kit, referred to as a ‘graphics application’. This application is geared towards providing a
reference for developing complex multi-threaded applications with a touchscreen graphical Human Machine
Interface (HMI) by using the Renesas Flexible Software Package (FSP) and SEGGER AppWizard.

09:45:41 AM 25 Nov 2024

THERMOSTAT

80°F

Partly Cloudy

50 % Humidity

-

e . | 5
‘S & EEY

84/73 7SI 4 74765 W 68760  76/70  83/72

Figure 1. Weather Panel of the Graphics Application on Renesas EK-RA6M3G

This application is developed using the Renesas RA Flexible Software Package (FSP), which provides a
quick and versatile way to build secure connected Internet of Things (IoT) devices using the Renesas RA
family of Arm®-based microcontrollers (MCUs). RA FSP provides production-ready peripheral drivers to take
advantage of the RA FSP ecosystem along with the SEGGER emWin library and FreeRTOS. In addition,
Ethernet, USB, and file system stack support are also available. This powerful suite of tools provides a
comprehensive, integrated framework for the rapid development of complex embedded applications.

This application note assumes that you are familiar with the concepts associated with writing multi-threaded
applications under a Real-Time Operating System (RTOS) environment, such as FreeRTOS. This
application note makes use of RTOS features such as threads and semaphores. Knowledge of operating
these with FreeRTOS can help in understanding the supplied application project in the source. For more
detailed information on FreeRTOS features, refer to the FreeRTOS User Manual.

The graphics application is developed using the Renesas e? studio Integrated Development Environment
(IDE). This e? studio is a free application that you can download from the Renesas website. While building
applications under the Renesas FSP Platform is considerably faster than developing similar applications in
other environments, there is still a learning curve to understand the steps necessary to construct complex
multi-threaded HMI applications quickly. This application note walks you through all the steps necessary,
including the following:

e Board setup.

e Application overview.

e Detailed explanation of uses of the graphical screens.

o SEGGER AppWizard project integration.

o SEGGER AppWizard interactions setup.

e Adding an emWin widget that is not yet available in AppWizard.

e FSP configuration.

e Application design highlights.

e Using the General-Purpose Timer to drive a PWM backlight control signal.
¢ Importing, loading, and running the project.
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Renesas RA Family Getting Started with the Graphics Application

Required Resources
Development tools and software

e e? studio v2024-10
e? studio | Renesas

e Renesas Flexible Software Package (FSP) v5.6.0
RA Flexible Software Package (FSP) | Renesas

e AppWizard V1.52_6.44b
SEGGER emWin GUI Library for Renesas RA Products | Renesas
Note: The version emWin in FSP must match the emWin version in the Segger AppWizard. There is a
limitation of our FSP versioning system; for example, the emWin version 6.44.2 in FSP is equivalent to
6.44b in the AppWizard V1.52_6.44b, and so on.

Hardware

o Renesas EK-RA6M3G kit (RA6M3 MCU Group)
(https://www.renesas.com/us/en/products/software-tools/boards-and-kits/eval-kits/ek-rabm3g.html)

Reference Manuals

¢ RA Flexible Software Package Documentation Release v5.6.0
o AppWizard User Guide & Reference Manual Version 1.52

¢ emWin User Guide & Reference Manual Version 6.46

e Renesas RA6M3 Group User’'s Manual Rev.1.20

¢ EK-RA6M3G-v1.0 Schematics
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Renesas RA Family Getting Started with the Graphics Application

1. Board Setup

The EK-RAB6M3G kit contains a few switch settings that must be configured before running the application
associated with this application note. In addition to these switch settings, the boards also contain a USB
debug port and connectors to access the J-Link® programming interface.

Table 1. Switch Settings for EK-RA6M3G

Switch Setting
J8 Jumper on pins 1-2
J9 Open

Figure 2. J8 and J9 on EK-RA6M3

The EK-RA6M3G kit consists of two boards: the EK-RA6M3 board featuring the RA6M3 MCU with an on-
chip Graphics LCD Controller and a Graphics Expansion Board featuring a 4.3-inch 480 x 272-pixel TFT
color LCD with capacitive touch overlay. The GPIO port pin driving the backlight controller is capable of
PWM output using a timer peripheral in the MCU. As a result, the intensity of the LED backlight can be

adjusted by the RA6M3 MCU.
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Figure 3. EK-RA6M3G Kit

R11AN0463EU0230 Rev.2.30 Page 4 of 39
Nov.25.24 RENESAS




Renesas RA Family Getting Started with the Graphics Application

2. Application Overview

One of the key goals of the provided graphics application is to demonstrate how to build applications that
require complex HMI screens using SEGGER AppWizard and emWin library. The following list highlights all
the key features of the graphics application:

e Complex HMI design using AppWizard.

e Multi-threaded applications using FreeRTOS
— Semaphore object.

e GLCDC configuration
— Framebuffer configuration.
— TCON configuration.

e Touch Panel, 12C touch controller driver ft5x06.
— External IRQ mapping is required.

There are many ways to solve the same problem in any software design. The solution given in this
application note is one approach.

2.1 RA6M3 MCU Peripherals Used by the Graphics Application

The graphics application is complex, and it uses the Renesas RA6M3 MCU. This MCU is built around an
Arm® Cortex®-M4 device. Developing complex microcontroller-based applications is usually a multi-step
process:

1. The first step usually involves gathering the application requirements and performing a high-level system
design that maps the requirements onto the set of hardware components. The components necessary to
fulfill those requirements include the target MCU used in the design, the tool chains required to
build/debug the applications, and so forth.

2. The next step usually determines which on-board peripherals of the target MCU are used. In this step, it
is often necessary to spend considerable time understanding the onboard peripherals' register map and
writing the lower-level driver code necessary to expose the peripheral to the upper-level application
code. Most of this work has already been done in the FSP, considerably streamlining application
development.

3. Besides the on-board peripherals of the target MCU, the design often encompasses external hardware
and how it is controlled. For example, the EK-RA6M3G has a Graphics Expansion board, which is
controlled directly by the on-chip Graphics LCD Controller (GLCDC) of the RA6M3 MCU.

4. The last step usually details how an application will be structured on top of the selected hardware to
accomplish the initial requirements.

The graphics application requirements were first mapped to the onboard peripherals of the EK-RA6M3G
kit. Figure 4 shows all the internal hardware peripherals used by the graphics application. This
application note describes how each of these peripherals is configured using the FSP and the
considerations that were used for each peripheral as the application is being developed.
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Renesas RA Family

Getting Started with the Graphics Application

RAG6M3 120MHz 32-Bit Arm® Cortex®-M4 Core

@ Memory

Code Flash (1MB, 2MB)

SRAM (480kB) Parity
SRAMHS (128kB) Parity

SRAM (32kB) ECC

Data Flash (64kB)
Standby SRAM (8kB)

@Communication

Y Analogue

12-bit A/D (13ch) 3SH

12-bit A/D (11¢h) 3SMH
12-bit DAC (2ch)

3ch PGA for each ADC

High Speed Comparator (Gch)

Temperature Sensor

@ System

O Timers

GPT HighRes 32-bit (4ch)
I GPT Enh. 32-bit (4ch) I

GPT 32-bit (6¢h)
Low Power GPT (2ch)
WDT

I RTC, Calendar, Vbat ]

@ Safety

NVIC | JTAG | SWD | ETM

?b HMI

Graphic LCD Controller
for TFT

2D Drawing Engine

JPEG Codec

Capacitive Touch Sensing
Unit (18ch)

Parallel Capture Unit

ﬁ Security

AES (128/192/256)

Ethemet MAC with DMA DMA (8ch) Memaory Protection Unit TRNG
USB2.0 FS x1 DTC SRAM Parity Check Key "éﬂfgﬁmﬁm
USB2.0 HS x1 Clock Generation ECC in SRAM SHA1/SHAZ24/SHAZ56G

CANZ On-Chip Oscillator POE ECC/RSA/DSA
12C x3 TOCO (16,16,20MMz), Clock Frequency 3DES/ARCA
MOCO (BMHZ Accuracy Measurement
SClx10
LOCO (32kHz), CRC Calculator S
SPI X2 e . Package
ol Low Power Modes lWD-T o
SDHI x2 Data Operation Circuit LQFP 100, 144, 176
ELC Flash Area Protection
551 x2 and SRC
[ Interrupt Controller ] ADC Self Test LGA 145, BGA 176

External Memory Bus

Figure 4. RA6M3 MCU Peripherals Used in the Graphics Application

2.2 Human-Machine Interface (HMI)

In many HMI applications, the most daunting task may be the GUI itself. In applications requiring a graphical
HMI, it is generally considered best practice to separate the business logic from the presentation. This
abstracts the GUI from making decisions on what to display. Instead, it is now only concerned about how to
display it. It relies on external logic to tell it what to display and when to display it.

Once you have gathered the requirements, achieved a top-level design, and identified the hardware
necessary to implement that design, it is often beneficial to construct a GUI (Graphical User Interface) to help
quickly communicate the look and feel of the system to others. This is where the SEGGER AppWizard
comes into play.

The FSP natively supports the use of AppWizard and emWin library from SEGGER. You may choose to use
emWin primitive calls directly in your application or choose to use the AppWizard to design your screens.
AppWizard is a stand-alone tool that provides a point-and-click environment for generating all the screens
necessary for your embedded application. Once designed, the tool outputs . c and . h files, which you then

include in your application. All the application screens in the graphics application were built using the
AppWizard.
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Renesas RA Family Getting Started with the Graphics Application

2.3 Graphics Application Panels

The graphics application consists of two graphical panels: a Weather Panel and a Logging Panel. In this

application, we build separate static display designs for these two panels. The screen resolution on the EK-
RABM3G kit is 480 x 272 pixels.

Weather Panel

v &gﬁ = Graphics_App_EK_RABM3G [Debug]
> [l Includes
v 3 AppWizard
7 [z Resource 8 OD F
> E_IH' Source Fartly Cloudy
> @& Simulation 50 % Humidity
? (,E Target ;
I ﬂ AppWizard.AppWizard
|5 BmpCvtlog
|5 FileListtxt BL/T3 17167
> g src
» [ script
454 configurationxml
|53 Graphics_App_EK_RAB6M3G Debug.jlink

THERMOSTAT

'

PS0N w  VON
.

Application Event
\¥4 Graphics_App_EK_RA6M3G Debug.launch
[5) RTFA6BM3AH3CFC.pincfg ForecastWED
= Forecast SUN
= ra_cfg.txt Forecast:THU
|5 RABM3G-EK pincfg ForecastFRI
: Forecast:SAT
> =
@ Developer Assistance Target Temp71
Target Temp.72
Target Temp:71
Target Temp:70
Target Temp:69
Logging Panel
Figure 5. Screenshot of the Graphics Application
Weather Panel This is the first screen that appears on the kit when booting up. It shows Weather
forecasts by selecting days or increasing/decreasing Temperatures.
Logging Panel This panel shows events that occur in the Weather Panel and adjusts the LCD

backlight or text color and background color of the Logging Editor.

3. AppWizard Overview

This section provides an overview of how graphical screens are designed and integrated into an FSP
application using the AppWizard and emWin library. It is not meant to replace the AppWizard or emWin
documentation. When designing graphical interfaces for the Renesas FSP platform, you are encouraged to
refer to the documentation for the AppWizard and emWin library.

The AppWizard presents a graphical point-and-click environment that allows you to quickly create all the
screens needed for your embedded application. You can specify the screen resolution, color depth, and
various other parameters such that what you see in the AppWizard that is running on your PC is what you
will get on your embedded screens.

The AppWizard comes as a standard with some fonts and basic graphics for interfaces such as image, text,
button, rotary, slider, and so forth. During your screen creation phase, you may provide the AppWizard with
your own external images and font files to make your displays as fancy as needed.
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Renesas RA Family Getting Started with the Graphics Application

AppW\zard V1.42_6.36 - AppWizard = [m] bd
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INITD... SETV.
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Figure 6. Screenshot of the Weather Panel being designed in the AppWizard

The organization of the AppWizard is straightforward. The top center window, known as the Editor window,
contains the screen being designed. In the upper left corner, you will find the Add objects window. This
window shows the supported window objects in the AppWizard. It allows you to click on the object icons and
drag and place them in the Editor window. On the center-left is the Hierarchic tree window. The order in
which you add items in the same level/parent determines the order in which they are drawn in the final
screens, so some planning is necessary. However, you still can change the order by using drag and drop or
the Move Up and Move Down buttons. As is the case with most graphical design environments, screens are
laid out in a hierarchy where the main window is usually the parent, and all graphical objects contained in the
window are children of that parent. The Properties window on the right side displays properties associated
with a selected object. You may select objects from the Hierarchic tree window or from the Editor window.

The bottom left of the AppWizard screen contains Quick Access Buttons for managing resources such as
Texts, Fonts, Images, Animations and Variables that you use to create and interact with the screens.
AppWizard supports multi-language designs as well.

The key to making any graphical design interactive is to associate events like button touches with the event
handling code that implements the appropriate functionality. The Interactions window at the bottom center
makes it easy for you to define the application’s behavior regarding certain actions. These interactions can
be done without any extra code, but AppWizard allows you to add your code to handle these actions and
respond to GUI events.
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Emitter Signal Job Receiver Comment
ID_SCREEN_MAIN INITDIALOG SETVIS ID_IMAGE_SUN_PRI
] REEN_MAIN INITDIA SETVIS ID_IMAGE_SUN
CREEN_MAIN INITDIALOG SETVIS ID_IMAGE_MON_|
INITDIALOG SETVIS 1D_IMAGE_MON
SETVIS ID_IMAGE_TUE_|
SCREEN_MAIN O SETVIS ID_IMAGE_TUE
REEN_MAIN SETVIS
INITDIALOG SETVIS ID_IMAGE_WED
INITDIALOG SETVIS ID_IMAGE_THU_PRESSED
SETVIS
SCREEN_MAIN O SETVIS
REEN_MAIN SETVIS
SCREEN_MAIN SETVIS
SCREEN_MAIN SETVIS
REEN_MAIN SETVALUE
ID_VAR_TIME_UPDATE G Update time when this changed
ID_VAR_TARGET_TEMP SETVALUE _ _ _ Set Them t Target temp
ID_BUTTON_TEMP_UP ADDVALUE ID_VAR_TARGET_TEMP Increase Thermostat target temp
DDVALUE ID_VAR_TA| T_TEMP Reduce Then
SETVIS
SETVIS ID_IMAGE_SUN_PRESSED
OUD_M...

M e e e e

m

W oww W B

RELEASED
RELEASED

)

[

ANIM
RELEASED SETVIS
RELEASED SETVIS

SETVIS

SETVIS

RELEASED SETVIS
RELEASED SETVIS

CKED SETVIS G
SETVIS ID_IMAGE_’
ID_IMAGE_ANIM
SETVIS ID_IMAGE_WED
SETVIS ID_IMAGE_WED_PRESSED
SETVIS ID_IMAGE_THU
SETVIS ID_IMAGE_THU_PRESSED
OUD_M..

[
m

RELEASED
RELEASED
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Figure 7. AppWizard Interactions Window
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Renesas RA Family Getting Started with the Graphics Application

3.1 Create a New Project Using the AppWizard

The Create New Project dialog box is shown in Figure 8. This dialog box is where you specify the project-
specific information, such as the basic display settings, as well as the path information for where AppWizard
locates the files that result from the Export & Save process. The AppWizard also generates a simulation
project in the folder \Simulation located in the project folder.

When you perform Export & Save, the AppWizard creates . c and . h files that contain all the information
necessary to render the screens you built with AppWizard on the LCD in your embedded application. The
Project Path is where you specify the default output directory for the Source, Header, and Resource files.

Create new project X

Project
Project path: 3eu0210-fsp-graphics-app\Graphics_App_EK_RA6M3G\AppWizard | Browse |

Project name: AppWizard

BSP

Selected BSP: RA6M3G_E2S Select BSP

Color scheme and display options
Display size x:

Display size y: 272
Color format: 16 Bit, GUICC
Enable Multibuffering:

Text

Show text from SD-card: g
Show missing characters:

Enable bi-directional text:

Enable Thai support:

Focus

Enable focus support:

Select focus color:

Set focus radius:

Set focus width:

Animations
Minimum time per frame:

Scroller
Enable scroller support:

Simulation
Enable simulation:

Stay alive loop
Generate loop in MainTask():

Use of static memory devices
Enable use of static memory devices:

Run script
Script to be executed after export:

‘ ‘ Cancel

Figure 8. Create a New Project Dialog Box

It is a good practice to save the Source, Header, and Resource files relative to the e? studio location. This
makes it easy to move projects from one location to another or from one PC to another. In the case of the
graphics application, you can see that all the directories are located under the AppWizard folder in the
project directory created by e? studio. We recommend creating the e? studio project first, then creating the
AppWizard folder as an e? studio source folder before creating an AppWizard project named AppWizard
under the e? studio project folder.
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After generating the AppWizard, you should exclude the Simulation and Target folders from Build before
building the e? studio project. All the necessary library and header files for the target board are generated
after you finish adding the emWin stack to your e? studio project.

~ 1= Graphics_App_EK_RA6M3G [Debug]
it Includes
w B AppWizard
[== Resource
[= Source
@ Simulation
(2% Target
AppWizard AppWizard
|=| FileList.txt
2 ra
i ra_gen
2 src
[= ra_cfg
[= script
fia:g cenfiguration.xml
Graphics_App_EK_RABM3G Debug,jlink
Graphics_App_EK_RAEBM3G Debug.aunch
R7FABM3IAHICFC pincfg
ra_cfg.tat
|| RABM3G-EK.pincfg
{?) Developer Assistance

Figure 9. AppWizard Project File View in the Graphics Application Folder

Go to Project > Properties > C/C++ Build > Settings > GNU ARM Cross C Compiler > Includes to add
the newly created AppWizard folder and its subfolders to the e? studio project; include the path as shown in
Figure 10.

E Add directory path >

Directory:

| "Sworkspace_loc/S{ProjMame}l/AppWizard}"

[]i&dd subdirectories

Cancel Workspace... File system...

Figure 10. Adding the AppWizard Folder to the e? studio Project Includes Path
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Renesas RA Family Getting Started with the Graphics Application
3.2 Design Weather Panel Buttons Using AppWizard

The AppWizard User Manual and Quick Start Guide cover basic designs. The Weather Panel buttons, on
the other hand, are more complex and are the target of this application note. These buttons are grouped in a
Window widget that includes multiple objects. For example, the window ID_WINDOW _SUN consists of:

e |ID_WINDOW_SUN
— Window widget. The placeholder to group the other widgets.

e ID_MAGE_SUN_PRESSED
— Image widget. Visible when the ID_BUTTON_SUN pressed, invisible when the ID_ BUTTON_SUN

released. Set bitmap using bottom button trans pressed.png.

W Set bitmap

P Enable tiling

Figure 11. ID_MAGE_SUN_PRESSED Bitmap Setting

e ID_IMAGE_SUN
— Image widget. Invisible when the ID_BUTTON_SUN is pressed, visible when the ID_ BUTTON_SUN is

released. Set bitmap using bottom button trans.png.

¥ Set bitmap

P Enable tiling

Figure 12. ID_MAGE_SUN Bitmap Setting

¢ ID_IMAGE_SUNNY_SUN
— Image widget. Sunny icon. Set bitmap using icon sunny.png.

¥ Set bitmap

P Enable tiling

Figure 13. ID_IMAGE_SUNNY_SUN Bitmap Setting

e |ID_TEXT_SUN
— Text widget. The “SUN” text.
e |ID TEXT_SUN_RANGE
— Text widget. Shows temperature range.
e |ID BUTTON_SUN
— Button widget. A transparent button without a bitmap image is placed on top of the other widgets.
Some AppWizard interaction setups must be in place to create button-pressed/release impressions.
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THERMOSTAT

I e

Figure 14. Design of the SUN Button Group

3.3 Setup AppWizard Interactions

Set the following interaction for the ID_BUTTON_SUN to create the button pressed/released as mentioned
earlier in the Weather Panel Button Design section:

o The ID_IMAGE_SUN widget is invisible, toggling from visible to invisible when the transparent
ID_BUTTON_SUN is pressed.

e The ID_IMAGE_SUN widget is visible, toggling from invisible to visible when the transparent
ID BUTTON_SUN is released.

Toggle
Slot: |D_SCREEN_MAIN__ID_BUT TON_SUN_ WM_NOTIFICATION_CLICKED__ID_IMAGE_SUN__APPW_JOB_SETVIS

Code: Edit code

Figure 15. ID_BUTTON_SUN Interaction When Clicked

N

ID_BUT TON_SUN RELEASED SETVIS ID_IMAGE_SUN
ID_BUTTON_SUN RELEASED SETVIS ID_IMAGE_SUN_PRESSED

Edit code

P B O 6 8 8 & & & &

+
+
5
+
:
+
n
;
+
+
5

7/
7/
7/
”
7
7/
7/
”
7/
7

.

Figure 16. ID_BUTTON_SUN Interaction When Released
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3.4 Add emWin Widget to AppWizard Project

You may need to use an emWin widget that is not yet supported by the AppWizard or need to create one in
your custom code. The AppWizard allows that capability via the emWin API calls.

The Logging Panel in this graphics application features a Logging dialog created by using the Multiline Text
widget.

The steps to add an emWin widget to the AppWizard project are as follows:

o Create an emWin widget by using emWin APIs in the slot routine for the AppWizard screen in the
CustomCode folder.

o Handle GUI events/messages if needed via slot routines in the file <ScreenID > Slots.c locatedin
the \AppWizard\Source\CustomCode folder.

o Figure 17 shows the function that creates the Multiline Text widget by using MULTIEDIT CreateEx API
and other APlIs.

ghMultiEdit = MULTIEDIT CreateEx(11, 93, 212, 178, pMsg->hWin, WM_CF_SHOW,

MULTIEDIT_CF_MOTION_V | MULTIEDIT_CF_READONLY, GUI_ID_MULTIEDITO, 16, NULL);
if(ghMultiEdit)
{

MULTIEDIT_SetBkColor(ghMultiEdit, MULTIEDIT_CI_READONLY, GUI_CUSTOM_COLOR);
MULTIEDIT SetWrapWord(ghMultiEdit);

MULTIEDIT_SetMaxNumChars(ghMultiEdit, LOG_CHAR_MAX);

MULTIEDIT SetTextColor(ghMultiEdit, MULTIEDIT_CI_READONLY, GUI_WHITE);

~ Ig§ - Graphics_App_EK_RABM3G il SEGGER Microcont
|
& B . .
W, Binanies #include "Application.h”
n Includes #include "../Generated/Resource.h”
v AppWizard #include "../Generated/ID_SCREEN_LOG.h"
y » Resource
® /*** Bagin of user le area ***
v En > Source B :
v & > CustomCode i
& Applicationc B * bID_SCREEN_LOG
R > Applicationh - void cbID_SCREEN_LOG(WM MESSAGE * pMsg) {
> ID_SCREEN_LOG _Slots. T E—
g > =L [ cuscbi_screen_Loc(phsg); |
ID_SCREEN_MAIN_Slots.c T

Figure 17. Adding Multiline Text Widget to AppWizard Application by using emWin APIs
4. Understanding the Graphics Application

While the HMI is certainly a large part of understanding any HMI application, there are many other areas that
you must understand while developing with the Renesas FSP applications. These include how the project is
physically structured in e? studio, how threads and thread resources are added to the project, how threads
communicate, the state machine design, and how state data is shared among cooperating threads,
especially the emWin thread.

4.1 Source Code Layout

Prior to diving into the actual application code, it is best to understand the overall source code layout of an
FSP project first. Renesas FSP applications generally consist of two different types of code: your code and
auto-generated code. The auto-generated code can be further broken down into two sub-categories: code
that is auto-generated by the FSP and code that is auto-generated by AppWizard.
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v 5 Graphics_App_EK_RA6M3G ug]
&J. Includes
v (2 AppWizard
(= Resource
(= Source
;Zﬁ Simulation
.2*/; Target
AppWizard. AppWizard
2 FileListtet
B ra
2 ra_ge
2 sre
(= ra_cfg
(= script
ﬁf configuration.xml
|=| Graphics_App_EK_RABM3G Debug.jlink
\=| Graphics_App_EK_RABM3G Debug.launch
| RTFA6M3AH3CFC.pincfg
= ra_cfg.bd
|=| RABM3G-EK.pincfg
(7) Developer Assistance

v (= Resource
(= Font
(= Image
= Text

v = Source

w (= CustomCode
lc] Application.c
ln Application.h
lc] ID_SCREEN_LOG_Slots.c
l€] ID_SCREEN_MAIN_Slots.c
lc| Log_Panel_Widget.c
L] Weather_Panel_Widget.c
v = Generated
a4t AFFWCont.c
4€) ID_SCREEN_LOG.c
' ID_SCREEN_LOG.h
JE) ID_SCREEN_MAIM.c
lh| ID_SCREEN_MAIN.h
L€ Resource.c
\h| Resource.h
[£] APPW_MainTask.c

v [ ra_gen
bsp_clock_cfg.h
common_data.c
common_data.h
emWin_thread.c
emWin_thread.h
hal_data.c
hal_data.h
main.c
pin_data.c
timer_thread.c
timer_thread.h
€] touch_thread.c
[B touch_thread.h
[g] vector_data.c
[ vector_data.h

FRERFEPERE

FREE

Figure 18. Graphics Application Project Source File Layout

Figure 18 shows the source code layout for the EK-RA6M3G board. FSP auto-generated code is in the
ra_gen folder, AppWizard auto-generated code is highlighted in the Generated folder, and the code you

generated is in the CustomCode folder.

Your generated code /AppWizard/Source/CustomCode is mainly used to handle HMI events. Your code
in the /src folder is related to MCU peripherals and other functionalities.
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4.2 Application Block Diagram

As mentioned, the graphics application consists of two panels: the Weather Panel and the Logging Panel.
The two application panels interface with the graphics framework through interaction such as touch events
and data (variables) changes. It communicates with FSP and HAL drivers to send and receive touch sensing
data, GPT PWM duty cycle, and RTC date and time.

The graphics framework includes the SEGGER AppWizard framework, emWin library, emWin RA port, and
interfaces with several HAL drivers such as GLCDC, JPEG CODEC, and D/AVE 2D. Figure 19 shows the
application diagram.

Graphics Application

Weather Panel

I

Logging Panel

I ry

Interactions

¥

Graphics Framework

SEGGER AppWizard/emWin

FreeRTOS SEGGER emWin RA Port

Touch sensor/PWM Control/Date, Time

4 ¥

Renesas Flexible Software Package (FSP)/HAL

|
|
M GLcDC IPEG D/AVE 2D 12C/Touch m
|
|
|

Renesas RA6M3 MCU

Figure 19. Application Block Diagram
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4.3 Thread Overview

As mentioned in the introduction, the graphics application is a multi-threaded application that runs under
FreeRTOS. There are two types of threads found in an FSP application: those created by you and those
created automatically to support the operation of FSP. While it is obvious what threads you created, it is not
always obvious what threads are created by FSP. The graphics application uses both user-created threads
and FSP threads. Threads communicate through the emWin-type events using AppWizard and emWin APlIs.
The emWin thread processes data and touch events that are sent by the Touch thread and Timer thread.
The FSP Configuration section details how to add your threads to your application. Figure 20 shows a high-
level diagram of the threads and event flow in the graphics application. Notice the distinction between your
threads and FSP threads.

User

<Thread> [ Function ] -

Initializes

emWin
Thread

Initializes

GUI Events

emWin Events

Executes

Touch
Thread

/ Timer \ Custom Event
\ Thread / Handlers

Figure 20. Graphics Application Event Flow

4.3.1 emWin Thread

The emWin thread is an HMI thread that initializes various services and resources used by the graphics
application. Once this initialization is complete, the emWin thread processes touch events and window
messages. If any of these inputs result in a change to the system state, the emWin invokes the AppWizard
Slot routines, which are the callback routines, resulting in changes to the graphical HMI. The flowchart in
Figure 21 gives the high-level view of the emWin Thread.

Setup AppWizard
Data, Resources

Initialize emWin (" Execute one job if any h
Internal Data, (Typically redrawing a
window) y

Create Initial
Screen
-~ @@ b J

Process Messages

Figure 21. High-Level View of the emWin Thread
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4.3.2 Touch Thread

A separate touch thread is created to read the touch sensor data. The touch sensor IC signals an event,
such as a user interaction on the LCD screen, by toggling a pin connected to the MCU. In response, the
touch thread reads the information from the touch sensor IC registers. Figure 21 shows the flowchart of the
touch thread.

Initialize Touch
Driver
y
Initialize External Wait for Touch External
IRQ IRQ

h

e ™
Read Touch Sensing
Data
N J
)

e ™
Send touch Sensing
Data to emWin Thread

- vy

Figure 22. Touch Thread Flowchart
5. FSP Configuration

One of the first things you must do when writing an FSP application is to configure the FSP. To properly
configure the FSP, you must have detailed knowledge of both the software design that you will be
implementing along with the specific hardware it will be running on. For the hardware, this includes the types
of peripherals to be used on the hardware, the pins they are mapped to, whether they are internal or external
to the MCU, and so on. From the software perspective, you need to decide how many threads will be used,
which threads need access to what hardware components, and what additional software objects, like
semaphores and queues, each thread will require. Once you have this information, you will be ready to
successfully configure the FSP for your specific application needs.

In the graphics application, the FSP configuration is stored in a file named configuration.xml. Double-
clicking on this file brings up the RA Configuration tab for the project.

w = Graphics_App_EK_RABM3G

[ Includes

2 AppWizard

2 ra

2 src

[= script

2% configuration.ml

= Graphics_App_EK_RAEBM3G Debug,jlink
=| Graphics_App_EK_RAEM3G Debug.launch
= R7FABM3IAHICFC. pincfg

= ra_cfg.bd

= RAGM3G-EK.pincfg

(%) Developer Assistance

Figure 23. configuration.xml on the Project Plane
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When a project is built from scratch, this configuration tab is where you will perform the initial configuration of
the FSP. As you can see in Figure 24, the RA Configuration pane contains a Summary tab highlighting the
items you may configure along with a scrolling window that lists all the software components currently
selected for this project. Below this scrolling window are tabs that allow you to tailor the FSP to the needs of
your specific application.

For the purposes of this application note, we will highlight a few of the details of the FSP configuration, such
as SEGGER emWin, the r_glcdc driver, the touch controller, and the PWM timer, as they pertain to the
graphics application. For additional details, refer to the Renesas Flexible Software Package (FSP) User’'s
Manual on how to configure the FSP.

When you have configured the project appropriately, click the Generate Project Content, the green arrow
button above the summary screen, to build all the auto-generated files necessary to implement the
components you defined.

Summary Generate Project Content
Project Summary ~
Board: EK-RABM3G RENESAS
Device: RTFABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version: 13.2.1.am-13-7
FSP Version: 560
Project Type: Flat
Location: C:/ra-solutions-rvc/application_p...raphics_ap/Graphics_App_EK_RABM3G ==

Selected software components

RABM3G-EK Board Support Files v56.0

Arm CMSIS Version 6 - Core (M) v6.1.0+fsp.5.6.0
FreeRTOS v10.6.1+fsp.5.6.0
FreeRTOS - Memory Management - Heap 4 v10.6.1+fsp.5.6.0
TES DAVE 2D Drawing Engine v3.8.0+fsp.5.6.0
SEGGER emWin Library v6.44 2+fsp 5.6.0
Board support package for RTFABM3AH3CFC v5.6.0

Board support package for RAGM3 v5.6.0
Board support package for RAGM3 - FSP Data v5.6.0
Board support package for RAGM3 - Evenls ~ v5.6.0

Board Support Package Common Files v5.6.0

TES D/AVE 2D Port v56.0

Data Transfer Controller v5.6.0

Gt P Torer weo

External Interrupt v5.6.0

12C Master Interface v5.6.0

/O Port v56.0

JPEG Codec v5.6.0

T e oo .

Figure 24. Summary of the Graphics Application Configuration

5.1 Components Tab
Even though the Components tab is the last tab showing, it is one of the first things you should configure.
Selecting components first makes them available in subsequent operations, such as mapping hardware
resources to specific threads in the Stacks tab. One of the advantages of FSP is that it will only compile in
the components you choose, thereby reducing the size of your overall application. As shown in Figure 25,
components are broken down into several categories.
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Components Configuration

— &

Component

o PSA
v o AWS
#% Abstractions
o c_sdk
% FreeRTOS
% FreeRTOS Plus
~ i Heaps
¥ FreeRTOS
% Libraries
~ % RIOS
~ @ FreeRTOS
V| all
an Intel
o Linaro
i LwiP_TCPIP
a1 Microsoft
w oy Renesas
@ BSP
% Common
% HAL Drivers
&% Middleware
o Projects
o TES
v o SEGGER
~ ¢t GUI
v @ all
¥ emWin

Version

10.6.1+fsp.5.6.0

6.44.2+fsp.5.6.0

Generate Project Content

Group by: |Vendor ~| Filter: |All

Description Variant il

SEGGER emWin Library

Figure 25. Components Tab Categories

You may expand any of the categories by clicking the arrow to the left of the category name.

The following table highlights the selections used for the graphics application.

Table 2. Components Used in the Graphics Application

Category Component Version Description
BSP raém3g ek 5.6.0 RA6M3G-EK Board Support
Package Files
CMSIS CoreM 6.1.0+fsp.5.6.0 Arm CMSIS Version 6 - Core (M)
Common fsp_common 5.6.0 Board Support Package Common
Files
GUl emWin 6.44.2+fsp5.6.0 SEGGER emWin Library
HAL r drw 5.6.0 TES D/AVE 2D Port
Drivers r dtc 5.6.0 Data Transfer Controller
r glecdc 5.6.0 Graphics LCD Controller
r icu 5.6.0 External Interrupt
r iic master 5.6.0 I2C Master Interface
r ioport 5.6.0 I/O Port
r jpeg 5.6.0 JPEG Codec
r rtc 5.6.0 Real-Time Clock
Heaps heap 4 10.6.1+fsp.5.6.0 FreeRTOS - Memory
Management — Heap 4
Middleware | rm emwin port | 5.6.0 SEGGER emWin RA Port
RTOS FreeRTOS 10.6.1+fsp.5.6.0 FreeRTOS
TES dave2d 3.8.0+fsp.5.6.0 TES DAVE 2D Drawing Engine

5.2 Stacks Tab
The Stacks tab is where you can add and configure the threads that the FSP automatically creates for your

application. You define a new thread by clicking the x

button and then entering a unique name for your

new thread. Once you add a new thread, you must define the modules that the thread will use along with any
thread objects that will be used by your thread.
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As an example, if you click the Threads panel and then single-click on the emWin Thread, you should see
something like the screen capture shown in Figure 26. This shows that the emWin thread requires multiple
modules, such as the GLCDC driver, which is used to control the LCD screen on the graphics expansion
board of the EK-RA6M3G kit.

¢ [Graphics_App_EX_RA6M3G] FSP Configuration X il |

Stacks Configuration Generate Project Content

Threads %] New Thread ] Remove - emWin Thread Stacks « | New Stack >

v m HAL/Common

@ g joport 0 Port ( joport & SEGGER emWin 4% FreeRTOS Heap 4
~ & emWin Thread

4% SEGGER emWin @ @

47 FreeRTOS Heap 4 =

~ @ Touch Thread =
g % SEGGER emWin RA Port (rm_emwin_port)
% g_touch_irg External IRQ (r_icu)

@ g_i2c_touch 12C Master (r_iic_master)

~ @& Timer Thread @

@ g_rtc_timer Realtime Clock (r_rtc) A
T T T

$ g_timer_PWM Timer, General PWM (r_gpt) = y . s -
% g_display0 Graphics LCD % D/AVE 2D Port Interface ¥ g_jpeg0 JPEG Codec
(r_gledc) (r_drw) (r_jpea)
@ @ @
| a
E— —

& D/AVE 2D (r_drw)

Objects % | New Object > o~
o
® g_touch_semaphore Binary Semaphore I
@ g_i2c_semaphore Binary Semaphore

@ g_timer_semaphore Binary Semaphore

Summary BSP Clocks | Pins | Interrupts | Event Links | Stacks Components

*! Problems | B Console | [ Properties X | @ Smart Browser |0} Smart Manual | [l Memory Usage | 35 Debug | 4" Search| [] Memory g
emWin Thread
Settings Property Value
~ Common
General
Hooks
Stats
Memory Allocation
Timers
Optional Functions
RA
Logging
~ Thread
Symbol emWin_thread
Name emWin Thread
Stack size (bytes) 4096
Priarity 10
Thread Context NULL
Memary Allocation Static
Allocate Secure Context Enable

Figure 26. emWin Thread Properties and Modules Used for the Graphics Application

You can add additional modules to any thread by clicking the = putton. If you have chosen the appropriate
components prior to adding modules to your threads, you should not receive any errors. As an example,
Figure 27 shows you how to add a GPT timer to the Timer Thread. The timer is added by choosing (+) New
Stack > Timers > Timer, General PWM (r_gpt)

If you have not preselected the appropriate component for a module that you select, the FSP automatically
selects the component for you. If the FSP detects errors with the module addition, it prefaces the module
with an error. You may examine the errors by hovering over the module name.
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¢ [Graphics_App_EK_RA6M3G] FSP Configuration >

Stacks Configuration

Threads % | New Thread % |Remove |-

v £ HAL/Common ~
4 g_ioport I/O Port (r_ioport)

v i emWin Thread
42 SEGGER emWin
4 FreeRTOS Heap 4

v i Touch Thread

4 a touch ira External IRO (r icu) M
< >

Objects & | New Object > % Remove

SEGGER emWin Stacks

4% SEGGER emWin

@
A
1
47 SEGGER emWin RA Port (rm_emwin_port)
@
A

@ g_touch_semaphore Binary e
@ g_i2c_semaphore Binary Semaphore
® g_timer_semaphore Binary Semaphore

T

€ g_display0 Graphics LCD
(r_gledc)

®

4% D/AVE 2D Port Interface
(r_drw)

@

@ g_jpeg0 JPEG Codec
(jpeg)

@

A

Summary | BSP  Clocks | Pins | Interrupts | Event Links | Stacks Components

4 D/AVE 2D (r_drw)

@

& | New Stack >

Al

Analog
Audio
Bootloader
CapTouch
Connectivity
DsP
Graphics
Input
Monitoring
Motor
Networking
Power
RTOS
Security
Sensor
Storage
System
Timers
Transfer

' Search...

-~y

= B | g% outline X | g Doc

o There is no active editol

Generate Project Content

4 Port Output Enable for GPT (r_poeg)
4 Realtime Clock (r_rtc)

4 Three-Phase PWM (r_gpt_three_phase)
< Timer, General PWM (r_gpt)

4 Timer, Low-Power (r_agt)

5.3

Figure 27. Adding r_gpt driver

Thread Objects

FreeRTOS supports various objects such as mutexes, queues, semaphores, and timers. In the Objects
window, you will see that there are three semaphore objects, g_touch_semaphore, g_i2c_semaphore, and
g_timer_semaphore, created for this application.

You can allocate additional thread objects by clicking on the “. button next to the Objects window. As you

can see in Figure 28, after clicking the button

<

in the Objects window, you will be presented with a drop-

down list that will allow you to add the standard thread objects supported by FreeRTOS.

Objects 4] New O @ Binary Semaphore
@ g_touch_semaphore Binary Semaphore @ Counting Semaphore
@ g_i2c_semaphore Binary Semaphore @ Event Group
@ g_timer_semaphore Binary Semaphore ® Message Buffer

&  Mutex
& Queue
&  Streamn Buffer
& Timer
[
Summary | B5P | Clecks | Pins | Interrupts | Event Links | Stacks | Components

Figure 28. Objects window

R11ANO463EU0230 Rev.2.30

Nov.25.24

RENESAS

Page 22 of 39




Renesas RA Family Getting Started with the Graphics Application

Objects % | New Object > # | Remove

@ g_touch_semaphore Binary Semaphore
@ g_i2c_semaphore Binary Semaphore
@ g_timer_semaphore Binary Semaphore

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks Components
[£ Problems & Console [] Properties > | &% Smart Browser L) Smart Manual Debug

g_touch_semaphore Binary Semaphore

Settings Property Value
Symbol g_touch_semaphore
Memory Allocation Static

Figure 29. g_touch_semaphore Properties

5.4 Module Configuration

Once you have added a module to your project, you need to configure its properties. The properties are
dependent on the module(s) that you have added. Use the Properties tab to configure them. The graphics
application adds the r glcd driver module as part of the SEGGER emWin stack. This module is used to
configure the GLCDC peripheral of the Renesas RA6M3 MCU.

5.4.1 GLCDC Configuration

As you can see in Figure 30, selecting the g_display0 Graphics LCD on the g_glecdc module under the
emWin Thread > Modules tab brings up the associated properties under the Properties tab. The first thing
you will notice is that it is a lengthy list of properties within the module group. The module group is where you
configure the GLCDC controller. These properties can be a bit daunting at first but can be broken down.
First, you will notice a few broad categories inside the module grouping.

¢ Name: The name given to this instance of the module g_display0 by default.

¢ Interrupts: You set the Line Detect interrupt and other interrupts here.

¢ Input: This block of module properties defines the input to the graphics controller, most notably, the
framebuffer name and the number of the framebuffers, the memory address where the frame buffer is
located, and others.

e Output: This is the area where you define the output properties of the GLCD. This includes properties
such as the total horizontal and video cycles, the active video cycles, both horizontal and vertical, front
and back porch duration, and so on.

e TCON: You use these lines in conjunction with the Pins tab to map the Horizontal Sync (Hsync), Vertical
Sync (Vsync), and Data Enable signals. You can specify the LCD panel clock divisor that divides the
clock input into the GCLD. This divisor ratio currently ranges from 1/1 to 1/32.

e Color Correction: This is where you can add various levels of color correction, for example, brightness,
contrast, and gamma, to your display. Color, contrast, and gamma correction of LCD screens are outside
the scope of this application note, but this is the area where you would do that type of adjustment.
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Stacks Configuration

Threads % | New Thread # |Remove — SEGGER emWin Stacks

v & HAL/Common

& g_ioport 1/0 Port (r_ioport)
v i emWin Thread

47 SEGGER emWin ®

47 FreeRTOS Heap 4 n
v & Touch Thread L

& g_touch_irq External IRQ (r_icu) 47 SEGGER emWin RA Port (rm_emwin_port)

4% SEGGER emWin

& g_i2c_touch 12C Master (r_iic_master)
v & Timer Thread

& g_rtc_timer Realtime Clock (r_rtc) @ ™

& g_timer_PWM Timer, General PWM (r_gpt) I T T

42 g_display0 Graphics LCD 4% D/AVE 2D Port Interface @ g_jpeg0 JPEG Codec
(r_glcdo) (r_drw) (r_jpeg)
Objects % | New Object > # | Remove @ @ ®

A
@ g_touch_semaphore Binary Semaphore I
® g_i2c_semaphore Binary Semaphore 4% D/AVE 2D (r_drw)
@ g_timer_semaphore Binary Semaphore

@

Summary | BSP | Clocks  Pins |Interrupts | Event Links  Stacks Components

1% Problems &) console| ] Properties X @ Smart Browser U’ Smart Manual ’i‘r Debug

g_display0 Graphics LCD (r_gledc)

Settings Property Value
API Inf ¥ Common
nfo
Parameter Checking Default (BSP)
Color Correction Off

v Module g_display0 Graphics LCD (r_glcdc)
General
Interrupts
Input
Output
CLuT
TCON
Color Correction
Dithering

Pins

Figure 30. GLCD Properties Configuration using the Properties Tab

5.4.2 TCON Configuration

If you scroll down a little further in the Properties tab, you will see four TCON properties. One of these is
associated with the Panel clock division ratio. This allows additional division of the pixel clock that is driven
directly from the PLLOUT branch of the clock tree. The other three are associated with the LCD sync signals.
These three signals can be confusing to new users, so how these signals map to the physical pins they are
connected to is discussed here.

w TCOM
Hsync pin select LCD_TCOMND
Ysynec pin select LCD_TCONT
Data enable (DE) pin select LCD_TCOMZ
Panel clock source Internal clock (GLCDMCLE])
Panel clock division ratio 1724

Figure 31. TCON Configuration for EK-RA6M3G Kit

To provide flexibility, the GLCD controller of the RA6M3 MCU provides two-pin grouping options. Each option
uses different pins on the MCU to drive the data lines connected to the LCD display. It is up to the hardware
designer to pick the group of pins they want to use. Picking one or the other may free up MCU pins that are
necessary for some other part of the hardware design.
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If you look at the schematics for the EK-RA6M3G kit, you can see the pins header for the LCD board. You
will also notice the three pins connected to the sync signals, which are highlighted in red. The data lines
chosen by the hardware designer must match one of the two pin groupings available under the GLCD
module.

LCD Module connected as Parallel RGB565 color depth.

71
1 >
[P1o4 DE | 3 :: 3 B0
P512/5CL2 SCL 5 el Bl
DATA1 PI107 B4 - B3 PI106  DATAO
DATA2  P600 B5 5 | o @l 10 B2
DATA4 P602 |~ B7 1| gal 2 B6 P601  DATA3
DATAS P610 2 El 4L GO
DATA7 PG6O8 G4 5 | o el 10 G3 P609  DATAG
DATA8 PIis G5 17 | ool 18 Gl
DATA10 P113 G7 9 | o el 20 G6 Pl14  DATA9
P511/SDA? SDA 21 | o ol 22 R
DATA12 Pl R4 3 | o el 2 ) PI12  DATAIl
DATA13 P301 RS 5 | ool 2 RO
DATA15 D303 R7 27 | o @l 28 R6 P302  DATA14
[FI02 HSYNC] 29 | o @120
51 | o @l 32 |[VSYNC P03 | +3V3
RO 53 [ ael it +5V
P304 RST 35 | o @l 20
P10l CLK 7 | o el 2t RO 206
P603 BIEN 30 | o @] 40

Figure 32. EK-RA6M3G LCD-Specific Signals from the Schematics

The easiest way to understand this is to go to the Pins tab in the RA Configuration. You will see selections
for Ports, Peripherals, and Other Pins, as shown in Figure 33. If you expand the Peripherals dialog, you
will see all the various MCU peripherals that can be configured from this screen.

If you scroll down to the Graphics: GLCDC entry and click to expand it, you will see two options: GLCDO
Pin Group Selection A and GLCDO Pin Group Selection B. For the EK-RA6M3G kit, the GLCDO Pin
Group Selection A was selected to drive the LCD display.

Notice that TCONO is associated with the Port 1 Pin 02 (P102). On the schematic (P102), we see that it is
connected to HSYNC, which is the horizontal synchronization pin for this LCD screen. Referring to Figure 31,
we see that TCONO has been selected to drive the HSYNC signal.
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Pins Configuration

Select pin configuration

RABM3G-EK. pincfg

e

Pin Selection

type filter text | /|

v Ports
+ Peripherals
Other Pins

Pin Configuration

| @B

Generate data:

o

Generate Project Content

&,

e~

g_bsp_pin_cfg

Summary |BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 33. Pin Configuration Tab

If you look at all the LCD data lines, such as

LCD_DATA_DATAOQO, and the pins they are connected to, they

should match the pins they are connected to on the schematic. Clicking on the arrow to the right of the pin
brings you directly to the associated Pin Configuration dialog, just as if you had selected the Ports Group
and then the specific port and pin that you are interested in.

Pin Configuration

Select Pin Configuration

Generate Project Content

i Export to CSV file |2- Configure Pin Driver Warnings

[ Generate data: ~ g_bsp_pin_cfg

#Jd cycle Pin Group
Value Lock Link ~
_Aonly

Custom

A

LLeeeeel oL olm

P101
P106
‘P07
P60
P&01
PEO2
¥ P610
P&09
PEO8
P115
P114
‘P13
¥ P112
P111
P301
¥ P302
P303

None

| By By E B ) 5 B

EL

5| B

Es

5 B

€

None
None
None
None
None
None
None
P102
¥ P103
P104

&L o

RABM3G-EK. pincfg ~| Manage
Riniseiection = 141 511%  Pin Configuration
Type filter text Name
v P7 Py Pin Group Selection
7 P8 Operation Mode
] ~ Input/Output
PA LCD_CLK
¥ PB LCD_DATADO
v ¢ Peripherals LCD_DATAO1
Manitoring:CAC LCD_DATA02
# Analog:ADC LCD_DATAQ3
Analog: ACMP LCD_DATAD4
Analog:DAC12 LCD_DATAQS
Connectivity:CAN LCD_DATA06
¥ Connectivity ETHERC LCD_DATAO7
¥ Connectivity:IIC LCD_DATAQB
¥ Connectivity:5C| LCD_DATAD9
¥ Connectivity:SP1 LCD_DATA10
Connectivity:S5| LCD_DATAT1
¥ Connectivity:USBFS LCD_DATAT2
# Connectivity:USBHS LCD_DATA13
Input:CTSU LCD_DATA14
7 InputIRQ LCD_DATA15
INpUtKINT LCD_DATA16
v ¥ Graphics:GLCDC LCD_DATA17
¥ GLCDCO LCD_DATATE
Graphics:PDC LCD_DATA19
¥ Storage:QSP! LCD_DATA20
Storage:SDHI LCD_DATA21
System:BUS LCD_DATA22
¥ System:CGC LCD_DATAZ3
¥ System:DEBUG LCD_TCONO
¥ System:TRACE LCD_TCON1
Timer:AGT LCD_TCON2
TimerGPT Module name:  GLCDCO
Timer:OPS
Timer:POEG
Timer:RTC .

Pin Function | Pin Number

Summary | BSP Clocks Pins Interrupts Event Links| Stacks Components

Figure 34. LCD Pin Configuration Using Configurator
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For example, clicking on this arrow to the right of the LCD_TCONO pin should bring you to the Pin Selection
Screen that looks like Figure 35. Notice that the pin is appropriately set to the Peripheral mode. At the time
of writing this application note, the pins default to no pull-up, high drive capacity, and CMOS output type.
Clicking on the arrow button to the right of this screen brings you back to the associated peripheral screen.

Select Pin Configuration L Expert to CSVfile 5= Configure Pin Driver Warnings

RAGI3G-EK pincfg ~ | Manage [l Generate data: | g_bsp_pin_cg
Pin Selection i= # =11%  Pin Configuration “XCycle Pin Group
Type filter text Name Value Link
o — " symbolic Mame
PO Comment.
vem Mode Peripheral mode
100 Pull up Mane
P01 Drive Capacity High
e B Qutput type cMos
03 ¥ Input/Output -
P04 P102 GLEDCO_LCD_TCONO =)
P105
Module name: P02
7 P106
P07 Port Capabilities:  ADCO: ADTRG
AGTO: AGTO
:gg BUS0: D2_DQ2
. CANQ: CRX
P GLEDCD: LED_TCONO
P11 GPT2: GTIOCB
7 P12 KINTO: KRM2
7 P113 OPS0: GTOWLO
P14 SCI0: SCK
PS5 SPIO: RSPCK
P2
P3
P4
5
PG v

Pin Function | Pin Number,

Summary BSP | Clocks Pins Interrupts Event Links Stacks Components

Figure 35. LCD_TCONO Settings in Pin Selection window

5.4.3 Touch Controller Configuration
The touch event on the LCD screen is sensed by the RA6M3 MCU external IRQ pin, and the touch sensor is
read via the 12C master.

As shown in Figure 38, the interrupt signal of the Touch Controller on the LCD screen connected to P206 on
header J1 of the EK-RA6MS3 board, which is MCU IRQ channel 0. The r icuand r iic master drivers
are added to a Touch Thread to handle the IRQ channel 0 and 12C Master Channel 2, respectively.

(]

Stacks Configuration Generate Project Cantent

Threads

& New Thread %] Remove =

v = HAL/Comman
4 g_ioport 1/O Port (r_icport)
~ & emWin Thread
& SEGGER emWin
4 FreeRTOS Heap 4
v & Touch Thread
4 g_tauch_irq External IRQ (r_icu)
@ g_i2c_touch 12C Master (r_iic_master)
v {@ Timer Thread
# g_rtc_timer Realtime Clack (r_rtc)
$ g_timer_PWM Timer, General PWM (r_gpt)

Objects % | New Object > ® |Remove

@ g_touch_semaphore Binary Semaphore
® g_i2c_semaphore Binary Semaphare
® g_timer_semaphore Binary Semaphore

Touch Thread Stacks

+i* g touch_irg External IRQ:
tricu)

o

@ g_izc_touch 12C Master (r_iic_master)

@©

a

Summary | BSP | Clocks Pins | Interrupts Event Links Stacks Companents

[£! problems | & Console [ Properties @4 Smart Browser - Smart Manual| 45 Debug

g_touch_irq External IRQ (r_icu)

Settings  FroPerty
~ Comman
AP Info
Parameter Checking
~ Madule g_touch_irq External IRQ (r_icu)
Name
Channel
Trigger
Digital Filtering

Digital Filtering Sample Clock (Only valid when Digital Filtering is Enabled)

Callback

Pin Interrupt Priofity
¥ Pins

1RQOD

$ g_transfer0 Transfer @ g transfer] Transfer
(r_cite) 11C2 TXI (Transmit (r_dite) 11C2 RX| (Receive
data empty) data full)

@ @

Value

Default (BSP)

g_touch_irg
0

Falling
Enabled
PCLK /64
touch_irq_cb
Priority 5

None

) New Stack > = Extend Stack > %] Remave

Figure 36. External Interrupt Configuration
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Stacks co"ﬁguration Generate Project Content
Threads 4| New Thread % |Remove ||  Touch Thread Stacks & New Stack > = Extend Stack > % Remove
v “’7“’ HAL/Common ~ o i
40 g.ioport /0 Port (r_ioport) & g_?ouch_\rq External IRQ
v & emWin Thread (ried)
47 SEGGER emWin ®
47 FreeRTOS Heap 4
v i Touch Thread L L
42 g_touch_irq External IRQ (r_icu) @ g_transfer0 Transfer @ g_transfer1 Transfer
% g i2c_touch 12C Master (r_iic_master) (r_dtc) 11C2 TXI (Transmit (r_dtc) IIC2 RXI (Receive
‘e Timge; Tr;read - . data empty) data full)
@ @
Objects 4| New Object > % | Remove
@ g_touch_semaphore Binary Semaphore
® g_i2c_semaphore Binary Semaphore
® g_timer_semaphore Binary Semaphore
Summary | BSP  Clocks | Pins ‘ Interrupts ‘ Event Links  Stacks | Components
[£2 Problems | & Console‘m Properties X ‘9, Smart Browser‘ 2 Smart Manua\‘ 1 Debug
g_i2c_touch 12C Master (r_iic_master)
Settings  Propery Value
v Common
API Info N
Parameter Checking Default (BSP)
DTC on Transmission and Reception Enabled
10-bit slave addressing Disabled
v Module g_i2c_touch 12C Master (r_iic_master)
Name g_i2c_touch
Channel 2
Rate Fast-mode
Rise Time (ns) 120
Fall Time (ns) 120
Duty Cycle (%) 50
Slave Address 0x38
Address Mode 7-Bit
Timeout Mode Short Mode
Timeout during SCL Low Enabled
Callback touch_i2c_callback
Interrupt Priority Level Priority 6
v Pins
SDA P511
SCL P512
Figure 37. 12C Master Driver Configuration
LCD Module connected as Parallel RGBSE5 color depth.
1
R S PP
DE 3 o0 4 BO
[Es1255c SCL] S1oglt Bl
DATA1 P10V B4 7 P 8 B3 P1046 DATAQ
DATA2 P600 B3 L] e 10 B2
DATA4 Pel2 B7 11 ey 12 B& P&01 DATA3
DATAS P6l0 G2 Ll gl 4 G
DATAT Pels 4 15 * ; 16 G3 P&09 DATAS
DATAR PI15 G 1/ | g @18 Gl
DATALD P113 G7 19 Pt 20 Gb Pl14 DATAS
| E311iSDA2 DA | 21 iyt 12 Rl
DATA12™TFTIIT T 23 ey 24 B3 Pl12 DATAILL
DATAI3 P301 |15 23 o0 28 k2
DATA1S P303 R7 27 | g g 28 Ré P302 DATAL4
P102 HSYNC 2% P 30
él oo - VSYNC P103 +3V3
RO 33 ea 34, +V
| DY RST ELT - 36
P10 L] 37 1 oot I[E 200
(i) BLEN ] 40
3 ) 28

Figure 38. Touch Controller Signals

The EK-RA6M3G User Manual recommends the touch interrupt input must have the internal pull-up feature
enabled. Use Ports Configuration for this setting instead of Peripherals Configuration.
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Pin Configuration Generate Project Content

Select Pin Configuration [ Export to CSV file [i=| Configure Pin Driver Warnings
‘ RA6M3G-EK.pincfg V‘ Manage [ Generate data: | g_bsp_pin_cfg
Pin Selection i= [+ I=11% Pin Configuration “J Cycle Pin Group
‘ ‘ ‘ Name Value Link
v P2 N Symbolic Name
P200 Comment
201 Mode Input mode
202 Pull up input pull-up
v p203 IRQ : IRQO-DS
/ p204 Drive Capacity Low
7 P205 Output type CMOS
v P206 v Input/Output
P207 P206 ¥ GPIO
¥ P208
Module name: P206
v P209
/ P210 Port Capabilities: E:;SSOV\@I‘;
‘P ETHERCO: LINKSTA
7 P212 ETHERCO: LINKSTA
7 P13 1IC1: SDA
7 p214 IRQQ: IRQO0
7 P3 OPSQ: GTIU
v P4 SCl4: RXD_MISO
v P5 SCl4: SCL
’/ P6 SDHI0: DAT2
;b7 SPIT: SSL1
v P8 SSI1: SSIDATA
s p9 USBFS0: VBUSEN
PA v

Pin Function | Pin Number

Figure 39. Touch Controller Interrupt Configuration

Note: When creating a project from scratch, you must add the touch driver to your project by copying the
touch £t5x06 folder in this application note project to the new project. Go to Project > Properties
> C/C++ Build > Settings > GNU ARM Cross C Compiler > Includes to add its include path.

1= Graphics_App_EK_RAGM3G
;;';? Binaries
i Includes
& AppWizard
= ra
2 ra_gen
v [ src
v = touch_ft5x06
[ touch_ft5x06.c
touch_ft3x06.h
[€] APPW_X_NoFS.c
[ emWin_thread_entry.c
[ hal_entry.c
[ timer_thread_entry.c
[ touch_thread_entry.c

Figure 40. Backlight Control Pin on EK-RA6M3G

[ Add directory path *

Directory:

| S{workspace_loc:/S{P rojName}_a'src_a'touch_ftﬁx{)ﬁ}{

[] Add subdirectories

Cancel Workspace... File system...

Figure 41. Add Touch Driver Folder to the List of Include Paths

5.4.4 PWM Configuration

The LCD_BLEN signal (Blanking Enable), which is connected to the P603 on the RA6M3 MCU, is configured
in PWM mode to control the intensity of the LCD backlight. Figure 42 shows an excerpt from the Graphics
Expansion board schematic, which shows the LCD_BLEN signal connected to the backlight controller.
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Figure 42. Backlight Control Pin on EK-RA6M3G

In Pin Configuration, set P603 as the GTIOCA output of the GPT channel 7. The Pin Group Selection is
set as mixed, and the Operation Mode is GTIOCA or GTIOCB.

q - o o
Pin Conflguratlon Generate Project Content

Select Pin Configuration =] Export to CSV file |- Configure Pin Driver Warnings

| RA6M3G-EK pincfg v| Manage [ Generate data: | g_bsp_pin_cfg
Pin Selection i= 1+ 1=11% Ppin Configuration ~J Cycle Pin Group
‘ Type filter text Name Value Lock Link
GPT2 ~ Pin Group Selection Mixed
GPT3 Operation Mode GTIOCA or GTIOCB
oPTa ~ Input/Output
GPTS GTIOCA v P603 @ (=)
GPT6 GTIOCB None
v GPT7
GPT8
GPT9 Module name:  GPT
GPT10
GPT11
GPT12
GPT13
Timer:OPS
Timer:POEG
Timer:RTC
¢ Other Pins
v

Pin Function ' Pin Number

Figure 43. GPT PWM Channel 7 Pin Configuration

The r gpt inthe Timer thread is set in PWM mode to modulate LCD backlight intensity. In this graphics

application, moving a slider in the Logging Panel will generate a duty cycle percentage that will be
calculated into the GPT timer period and written to the counter register.
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Stacks Configuration Generate Project Content

Threads % | New Thread % |Remove |- g_timer_PWM Timer, General PWM (r_gpt) Stacks % | New Stack >

v iﬁ‘ HAL/Common
4% g_ioport I/0 Port (r_ioport)
v & emWin Thread
47 SEGGER emWin ®
4 FreeRTOS Heap 4
v & Touch Thread
& g_touch_irq External IRQ (r_icu)
$ g_i2c_touch 12C Master (r_iic_master)
v & Timer Thread
P g_rtc_timer Realtime Clock (r_rtc)
% g_timer_PWM Timer, General PWM (r_gpt)

@ g_timer_PWM Timer,
General PWM (r_gpt)

Objects % | New Object > % | Remove

@ g_touch_semaphore Binary Semaphore
@ g_i2c_semaphore Binary Semaphore
® g_timer_semaphore Binary Semaphore

Summary | BSP | Clocks | Pins | Interrupts Event Links Stacks Components
[ problems | & console [ Properties < @ Smart Browser K5 Smart Manual| % Debug

g_timer_PWM Timer, General PWM (r_gpt)

Settings Property Value
v Common
API Info .
Parameter Checking Default (BSP)
Pin Output Support Enabled
Write Protect Enable Disabled
¥ Module g_timer_PWM Timer, General PWM (r_gpt)
v General
Name g_timer_PWM
Channel 7
Mode Saw-wave PWM
Period 50
Period Unit Microseconds
v Output
> Custom Waveform
Duty Cycle Percent (only applicable in PWM mode) 50
GTIOCA Output Enabled True
GTIOCA Stop Level Pin Level Low
GTIOCB Output Enabled False
GTIOCB Stop Level Pin Level Low
Input
Interrupts
Extra Features
v Pins
GTIOCA P603
GTIOCB None

Figure 44. GPT Driver Configuration in PWM Mode

Figure 45 and Figure 46 show the AppWizard configuration for the backlight slider. Its range limits are from 5
to 100. Some interactions and custom code are needed to control the duty cycle of PWM output as well.
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Figure 45. Slider Setup to Control LCD Backlight Intensity
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* Get the SLicE"'ID_wAR_EACK_IGhT value*/
ghataApp.pwm_duty_cycle = (uint3_t)APPW_GetVarData(ID_VAR_BACKLIGHT, &gui_err);
if(gui_err)

APP_ERR_TRAP(gui_err);

¥

current_period_count = info.perioed_counts;

red duty ¢ e based on the current p od. Note that if the p

iod could be larger than
t is used to prev

ent this. The cast is

uint64

duty_cycle_count = (uint32_t) (((uint64_t) current_period_count * gDataApp.pwm_duty_cycle)/GPT_PWM_MAX_PERCENT);
R_GPT_DutyCycleSet(&g_timer_PWM_ctrl, duty_cycle_count, GPT_IO_PIN_GTIOCA);

Figure 46. Custom Code Controls PWM Update GPT Timer Duty Cycle
6. Application Code Highlights

This section details the highlights of the graphics application. The goal of the graphics application is to show
you how to develop more complex multi-threaded HMI applications using the FSP, AppWizard, and emWin
library.

The key goal of the FSP is to abstract much of the complexity of interfacing with various Renesas peripherals
and to quickly get you to the point where you can focus on constructing more complex applications as quickly
as possible.

6.1 Threads and Main

In the FSP, main () is an auto-generated file that looks like the following code. The threads and objects
specified during the FSP configuration are initialized in the main ().

int main(void)

g_fsp_common_thread_count = 8;
g_fsp_common_initialized = false;

/* Create semaphore to make sure common init is done before threads start running. */
_fsp_common_initialized_semaphore =
#if configSUPPORT_STATIC_ALLOCATION
xSemaphoreCreateCountingStatic(
gelse
xSemaphoreCreateCounting (
#endif
256,
1
#if configSUPPORT_STATIC_ALLOCATION
» &g _fsp_common_initialized_semaphore_memory
#endif
)i

if (NULL == g_fsp_common_initialized_semaphore)
{

rtos_startup_err_callback (g_fsp_common_initialized_semaphore, @);

* Init RTOS tasks. */
emWin_thread_create ();
touch_thread_create ();
timer_thread_create ();

/* Start the scheduler. *
vTaskStartSkhEdulEr 9 H
return @;

}

Figure 47. The main () function in FSP with FreeRTOS Enabled

When you create a thread using the New Threads tab, the FSP creates several files. As an example, when
the emWin Thread is added, the FSP creates three files for you: emWin thread.h, emWin thread.c,
and emWWin thread entry.c, as shown in Figure 48.

The first two files are auto-generated and, therefore, put into the ra_gen folder. The

emWin thread entry.c file is the entry point for the emWin Thread, and this is where you put your
application code. Auto-generated files should not be updated by the user since they will be re-generated
every time you build the project or click the Generate Project Content button. Auto-generated files always
contain some form of do not edit message at the top of the file.
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v (=% Graphics_App_EK_RA6M3G

[l Includes

[ AppWizard

[ ra

w 2 ra_gen

bsp_clock_cfg.h
[£] commen_data.c
common_data.h
€] emWin_thread.c
emWin_thread.h
[ hal_data.c
hal_data.h
[ main.c

[ pin_data.c
[£] timer_thread.c

timer_thread.h
[ touch_thread.c
touch_thread.h
[ vector_data.c
vector_data.h
w (2 src

= touch_ft3x06
[ APPW_X_NoFS.c

| [£] emWin_thread_entry.c
|| hal_entry.c
[ tirner_thread_entry.c
[ touch_thread_entry.c

= ra_cfg

Figure 48. FSP Generated Source File Organization

6.1.1 AppWizard/emWin Initialization
The FSP does not automatically initialize the AppWizard system. To initialize it, simply include GUI .h and
add the MainTask () APl callto emWin thread entry () located inthe emWin thread entry.c file.

#include "emWin thread.h”
[ #include "GUI.h" \
/* emWin thread entry function */

* pvParameters contains TaskHandle_t */
= void emWin_thread_entry(void *pvParameters)

FSP_PARAMETER_NOT_USED (pvParameters);

MainTask();

while (1)

vTaskDelay (1);
}
}

Figure 49. Backlight Control Pin on EK-RA6M3G

6.1.2 emWin Events and Messages

Touching the screen in the graphics application causes emWin to invoke the specific callback function
generated for that screen in the AppWizard. AppWizard provides the callback function with specific
information about the window that caused the event and the actual event that occurred. These events are
defined in WM. h.

You can add your code to slot routines in the file <ScreenID > Slots.c located in the
\AppWizard\Source\CustomCode folder to handle window events. The slot routines are actual callback
routines generated by AppWizard. Since the <ScreenID > Slots.c is updated whenever you add and
generate new widgets or AppWizard interactions using AppWizard. However, custom code will be retained. It
is a good practice to create your custom code in a separate file and call it in the appropriate slot routine.
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] f Custom code for cbID_SCREEN_MAIN in ID_SCREEN_MAIN_Slots.c[]
VDld cuscbID SCREEN_MAIN(WM_ME SSAGE = pMsg) {
int wid = @;
int wMsg = @;

switch(pMsg->MsgId) {
case WM_INIT_DIALOG:
/* Get and store Images's handles */
1f(ImagEHandlEGEt(pr‘\sg))

APP_ERR_TRAP(FSP_ERR_INVALID POINTER);

'* set default weather forecast */
if (WeatherForecastInit(pMsg))

APP_ERR_TRAP(FSP_ERR_INVALID POINTER);

* Set Thermostat target temperature */
APPW_SetVarData(ID VAR _TARGET TEMP, gDataApp.thermo_target_temp);
/* Save logging */

LogDataAppend(gDatalog, sizeof(gDatalog),"\n¥%s", "Init Dialog");
/* Create timer to control effects/animation*/
ghTimer = WM_CreateTimer(pMsg->hWin, d, ANIM_TIMER_PERIOD, @);
break;

case WM_TIMER:

* Rainy effect*/
if (SYS_WEATHER_RAINY == gDataApp.sys_weather_type)
¢ if(@ == AnimRainyState)

i
/* Hide 1st animation image, show 2nd animation image *
WM_HideWindow(hImageAnimBGRD[gDataApp.sys_weather_type]);
W_Showiindow( hImageAnimBGRD[ IMAGE_ANIM_RAINY_BGRD 2]);

Figure 50. Custom Code for The Slot Routine cb_ID_SCREEN_MAIN

6.1.3 AppWizard Variables

Variables in the AppWizard can be used to store a value. They can be accessed and changed by the GUI or
from outside of the GUI. The GUI can react to a change of a variable using interactions. One of the typical
uses is to update the variables in a non-GUI thread to trigger data exchange between the AppWizard and
non-GUI threads.

/* Timer Thread entry function *

* pvParameters contains TaskHandle_t */

void timer_thread_entry(void *pvParameters)
FSP_PARAMETER_WOT_USED (pvParameters);

/* Set up GPT/PWM timer using for LCD back light control */
if(gpt_timer_PWM_setup())

APP_ERR_TRAP(FSP_ERR_ASSERTION);
'* Set up RTC timer
if(rtc_timer_setup())

APP_ERR_TRAP (FSP_ERR_ASSERTION) ;

while (1)
{

* Wait for interrupt from RTC timer */
xSemaphoreTake(g_timer_semaphore, portMAX_DELAY);

* Get date, time */
R_RTC_CalendarTimeGet(&g_rtc_timer_ctrl, &RtcTimeCurrent);
* Trigger GUI update’
APPW_SetVarData(ID_WAR_TIME_UPDATE, 1);

vTaskDelay (1);
}
¥

Figure 51. AppWizard Variable Update in Timer Thread

ID_VAR_TIME_UPDATE VALUE_CHANGED Update time when this changed

Edit code

X
X
b 4
X
X
X
X
X
X

Figure 52. Setup Interaction to perform Date, Time Update when ID_VAR_TIME_UPDATE is changed
in AppWizard
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7. Importing and Building the Project
To bring the graphics application into the e2studio, follow these steps:

Launch e? studio.

In the workspace launcher, browse to the workspace location of your choice.
Close the Welcome window.

In €2 studio, go to File > Import.

In the Import dialog box, pick Existing Projects in Workspace.

Select the archive file.

Select the Graphics_ App_EK_RA6M3G project and click Finish.

Open configuration.xmi.

9. Click on Generate Project Content on the FSP configurator window.

10. Now build the project.

8. Downloading the Executable to the EK-RA6M3G Kit

To connect and run the code, follow these steps:

Connect your PC to the USB port next to the Ethernet jack silkscreened DEBUG using a USB cable.
Go to Run > Debug Configurations.

Click Debug. The program will break at the reset handler.

Click Switch to the Debug perspective when prompted by the e? studio.

Click Run > Resume.

The Weather Panel will show as in Figure 53. You can select the forecast day or adjust the thermostat
temperature. Touch the top right corner to move to the Logging Panel.

NGO R WN =

ook wd -~

80°F

Partly Cloudy

50 % Humidity

Figure 53. The Weather Panel

The Logging Panel allows you to adjust the LCD backlight using the slider or change the Logging Dialog
text color and background color using the rotary and the switch, respectively. The logging buffer resets when
it reaches the limit of 256 bytes. Touch the Renesas logo to go back to the Weather Panel.

Application Event

ForecastWED
Forecast:SUN
Forecast: THU
Farecast:FRI
Forecast:SAT
Target Temp:71
Target Temp:72

Target Termp 71
Target Temp:70
Target Termp 69

Figure 54. The Logging Panel
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9. e?studio Tricks

The e? studio IDE has a handy feature that you can use to ensure that the images you are seeing on your
LCD screen are coming from your framebuffer. To use this feature, make sure to connect the e? studio to
your board and run the program under the debugger. Ensure that your Memory tab is open in the Console
window, normally located at the bottom of the screen in Debug view. Click the small green plus (+) sign in
the Monitors Pane to add a memory monitor. You should see a Monitor Memory dialog as shown in . Enter
the Framebuffer fb_background[0] or fb_background[1] and click the OK key.

A new tab should now appear under the Memory tab that displays the contents of the memory area you

specified for the memory monitor.

Eile Edit Source Refactor Navigate Search Project Renesas Views Run Renesas Al Window Help
| B -(~-Bie|bll B R Q- Q0350w S
35 Debug > = ;_| i# § = O | {& [Graphics_App_EK_RAGM3G] FSP Configuration Ll startup.c X | € main.c L portc

v [£7] Graphics_App_EK_RABM3G Debug [Renesas GDB Hardware Debt

v 'ﬂ‘: Graphics_App_EK_RA6M3G.elf [1] [cores: 0]

v o Thread #11 (single core) [core: 0] (Suspended : Signal : SIG

= Reset_Handler() at startup.c:50 Oxda9¢c

= BSP_SECTION_FLASH_GAP void Reset_Handler (void)

{

/* Initialize system using BSP. */
SystemInit();

» arm-none-eabi-gdb (12.1)

. /* Call user application. */
p Renesas GDB server (Host)

main();
a8

< PPN ‘

B Console | 1411 Registers | [§] Debug Shell| @ Memory x |[£]

Enter address or expression to monitor:

Monitors = K & fb_background[0] : Ox1 |fb_backgraund[1] v|
w fb_background[0] Address
B000R00R1FFFACCE (7) p—
0000000 1FFFACDO
0000000Q1FFFACEO 00000000 00000000 00000000
0000000Q1FFFACFO 00000000 00000000 00000000

TS T

wser | 4 Se

I F

00000000
00000000
00000000
00000000

Figure 55. Using the Memory Monitor to Display the Framebuffer Contents

You should now see the contents of the selected framebuffer memory area displayed in the memory monitor
you just created. If you know what the hex value of every pixel should be on your display, you would be able
to use this memory monitor to definitively say that your image is being stored in the framebuffer. However, as
most of us do not know the hex values associated with our pixels, we will let the memory monitor do the work

for us.
) Console J=| Tasks f/ Problems [} Debugger Console @ Smart Browser | [J Memory 52
Monitars &= 3¢ 8 (fb_background[1]: 0x20032880 <Hex Integer> £ i New Renderings...
@ fb_background[0] Address 8 -3 4-7 g8 -B C-F

i lEd gl 200PEORE20032550 821101F1  @1F181F@  B1F1@211
goppaeRR2ER32898  B2llelrFe @lFle2ll g2llezll @2lle2ll

coeooepR20032848 2 @1F18211 82118211 821181F1 82118211

BEEEEEEE20683 2588 82118211 BlFea21l1 82118211 B1F@alFl

poppoeRR2ER328C8  @lFee2ll glFealre 8lF1elrl BlF1elFe

gegeaaae 200832808 B21181F1 @1F18lFl BlF181FL B1F181F1

BEEEEEEE200328E0 B1F181Fl B1F181F1 BlFlelFe B21181F6

poepaeRR28@328F8  @1FBB211 82118211 81F1el1rl B1Fea211

BEEEEEEE 28832988 BlFeaz2ll BlFea2l1l BlF181FL B1F181F1

BEReaEEE28032018 B1Fle211 B1F181Fl BlFealFrl B1F181F1

coeeaeRR28@329286  @21181Fa8 @211alFa 82118211 82118211

BEREaEEE2BB32938 BlFeaz2ll B1F181F1 BlFealFrl B1F181F1

gopoaeRR22032048  B21181FL 821181F1 elFeelre 81lF1e1Fl

gegeBEEE2B832958 BlFealre BlFealrl BlFealre B1Dealrl

BEEEEEEE2068320958 Bl1FlelFe BlFealrl BlFEalFl B1F181F1

poppoeRR2EB32078  @LFBELFL 81lFealrl elFeelrl B1lF181F1

gegeBaaE2ee32988 BlFealre BlFealra BlFealre B1Fl1elre

ITAA2 2000 Q1FI1R1FE1 A1FE1A1E] Q1FARTFA ATF1A1E1

Figure 56. Framebuffer 1 Contents

Select the New Renderings tab next to the memory monitor you just created, select Raw Image type from

the list of options, and press the Add Rendering(s) button off to the right side of the screen.
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) Console | Tasks In‘: Problems [} Debugger Console @ Smart Browser | [J Memory i3 o g e B[ "“| El (3] i?}‘ Br =0
Monitors &= 3 5 |fb_background[1] <Hex Integer> (H,}u New Renderings...
% fb_background(0] [Memory Monitor: fb_background 1] : 020032880

@ fb_background[1] Select rendering(s) to create:

Waveform

Hex Integer

Fixed Floating Point
Fixed Point

Imaie

Floating Point
Traditional

Raw Hex

ASCH

Signed Integer
Unsigned Integer

Add Rendering(s)

Figure 57. Rendering Format Selection

The Raw Image Format dialog box appears, which lets you enter the screen resolution Width and Height,
along with the Encoding, which is 16 bpp (5:6:5) in our case.

& Console £ Tasks [ Problems 3 Debugger Conscle @ Smart Browser | [J Memory 52 S Mg w5 [ "'l tsl HA| 4:5‘ g = 8
Monitors & X & fb_background[1] <Hex Integer> (fbﬁbackgmundﬂ]:ﬂﬂmm <Raw Image> [ o5 New Renderingsq
@ fb_background[0] Raw Image Format... B8 Raw Image Format x
@ fb_background[1]
Dimensions
Width: | 480 |
Height: | 272 |
Encoding
(O Monochrome: Tbpp
(®) RGE: 16bpp (5:6:5) 7 |
() BGR: 32bpp (8:3:8:8)
OYChCr 32bpp (¥12-UV8 semi-planar)
Line alignment: 4 bytes ~

Start Position
® Top
() Bottom

@

Figure 58. Raw Image Format for Graphics Application on EK-RA6M3G

Once you press the OK key, the memory monitor presents you with the image that will be displayed at that
memory address based on the parameters you entered.

‘;1 Problems ‘ =] Ccnsule‘E Properties ‘\J, Smart Ercwser{[ﬂ, Smart Manual‘ Memory Usage"t} Debug| 4 Sear(h‘ 0 Memory X SRy e B ,f fl !:‘ ii ‘?@‘ Elb 2 ci = e
Monitors 4 38 3% b background[1] : 0x200348C0 <Raw Image> X | <= Ngwﬂgnderings‘..‘
@ fb_background[0]}
@ fb_background[1]}

09:45:41 AM 25 Nov 2024

THERMOSTAT

4 Hu‘m-m.-,- { “@ +

‘ ., | .
W-WTT: s TR
& LTS

77/67 || 74/65 '§ 68/60  76/70  83/72 2077

-

Figure 59. Image Rendering Using Seen Using e? studio Memory Monitor
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10. Website and Support

Visit the following URLSs to learn about key elements of the RA family, download components and related
documentation, and get support.

RA Product Information www.renesas.com/ra

RA Product Support Forum www.renesas.com/ra/forum

RA Flexible Software Package www.renesas.com/FSP

Renesas Support WWw.renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document, as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external
reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states
of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power

reaches the level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity
of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vix (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in
terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a

system-evaluation test for the given product.



Notice

1.

10.

1.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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